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Задание на курсовую работу:
Создание электронного образовательного ресурса на тему: «Средства поддержки анимации», где необходимо продемонстрировать на нескольких примерах принцип создания анимации. А так же сделать краткий обзор некоторых технологий создания и поддержки анимации 2D и 3D.


Введение
Актуальность темы «Анимация» сегодня не вызывает сомнения. Почти столетие назад появились первые мультфильмы, которые вызвали восторг у всех. С появлением современных технологий  анимация становится одним из главных элементов мультимедиа проектов и презентаций,  все чаще присутствует на интернет - страницах. Также анимация очень широко используется на телевидении. Например, многие телекомпании используют заставки, созданные с помощью компьютерной анимации. Создание видеопродукции также не обходится без компьютера, и все чаще профессиональное видео использует приемы компьютерной анимации.
В данной работе рассматриваются технологии и принципы создания анимации.


Анимация
Принятое в мире профессиональное определение «анимация» (в переводе с латинского «анима» – душа, «анимация» – оживление, одушевление) как нельзя более точно отражает все современные технические и художественные возможности анимационного кино, ведь мастера анимации не просто оживляют своих героев, а вкладывают в их создание частичку своей души.
Технологии создания анимации.

В настоящее время существует различные технологии создания анимации:
Классическая (традиционная) анимация представляет собой поочередную смену рисунков, каждый из которых нарисован отдельно. Это очень трудоемкий процесс, так как аниматорам приходится отдельно создавать каждый кадр.
Стоп-кадровая (кукольная) анимация. Размещенные в пространстве объекты фиксируются кадром, после чего их положение изменяется и вновь фиксируется.
Спрайтовая анимация реализуется при помощи языка программирования.
Морфинг – преобразование одного объекта в другой за счет генерации заданного количества промежуточных кадров.
Цветовая анимация – при ней изменяется лишь цвет, а не положение объекта.
3D-анимация создается при помощи специальных программ (например, 3D MAX). Картинки получаются путем визуализации сцены, а каждая сцена представляет собой набор объектов, источников света, текстур. 
Захват движения (Motion Capture) – первое направление анимации, которое дает возможность передавать естественные, реалистичные движения в реальном времени. Датчики прикрепляются на живого актера в тех местах, которые будут приведены в соответствие с контрольными точками компьютерной модели для ввода и оцифровки движения. Координаты актера и его ориентация в пространстве передаются графической станции, и анимационные модели оживают.
Программное обеспечение для создания анимаций.
Программное обеспечение для создания анимаций создает удобства в работе как для новичка, так и для опытного пользователя. Подобные программы обладают различными техническими особенностями, весьма полезными и легкими в использовании для аниматора. В любой момент времени пользователь может получить on-line помощь. Подобное программное обеспечение различается по двум категориям: для двухмерной (2D) и трехмерной (3D) анимации. На рынке в настоящее время присутствует огромное количество и разнообразие программ для создания анимаций. Многие из них широко доступны и имеют испытательный режим, в течение которого пользователь может пользоваться программой бесплатно. После истечения этого срока, если пользователь доволен программой, для дальнейшего ее использования он может купить полную версию.
Особенности программного обеспечения для двухмерной анимации (2D):
Большинство подобных программ имеет дружественный интерфейс и предлагает множество функций. Например, такие полезные особенности, как настраиваемая сетка и авто заполнение промежутка. Автоматизированная функция синхронизации изображения и речевых сигналов экономит время.
Библиотека шаблонов создана для организации, хранения и многократного использования всех ваших активов и созданных анимаций может содержать все виды медиа файлов: фильмы, собрания фотографий, художественные работы таких форматов как SWF, AI, PDF, JPEG, PSD, TGA и GIF.
Специальные программные элементы делают процесс создания анимации столь же легким как «раз, два, три». Программные инструменты позволяют пользователю создавать эффекты движения, масштабирования, вращения и искажения. Есть функция автоматической вставки ключевого кадра в линию времени.
Процесс создание места действия займет секунды с помощью функции "перетащи и оставь" и инструментов проектирования места. Особенность создания тени добавит реалистичности анимации. Благодаря программе, процесс создания анимации становится легким занятием независимо от того, насколько сложна сама ее идея.
Создание или компилирование высококачественных анимаций для сети, КПК, iPod, сотовых телефонов, HDTV, включая SWF, AVI, QuickTime, DV потоков и многое другое.
Необходимые системные требования для работы программного обеспечения двухмерной анимации: 
Для операционной системы Макинтош - Power Macintosh G5, G4 (минимум), или Интел (r) CoreTM, процессор Mac OS X v10.4.7, ОЗУ (оперативная память) 512 МБ (или больше), 120 МБ доступного места на жестком диске, 24 битный цветной монитор, с 64 МБ (рекомендуется) или 8 МБ (минимум) видео памятью, со способностью разрешения до 1024x768 точек.
Для систем ПК - процессор 800 МГЦ Intel Pentium III (минимум) с Windows Microsoft XP или 2000, (рекомендуется) ОЗУ 512 МБ, 256 МБ (или больше), 120 МБ доступного места на жестком диске, 24 битный цветной монитор, видео память 32 МБ или больше, способность к разрешению в 1024x768 точек.
Особенности программного обеспечения для создания трехмерной анимации (3D):
Трехмерные средства модулирования, поддержка шрифта TrueType, импорт и изменения форматы файла, экспорт файлов 3DS, встроенный трехмерный браузер, составной символьный редактор, изменение объектов, рендерер для высокого качества, создание высококачественных изображений, создание трехмерных сцен и анимаций, поддержка рамок, рельефных преобразований, создание мягких теней, центров внимания, эффекта тумана, и многое другое, поддержка файлов форматов .BMP.GIF, и .JPG, скрипт язык и т.д.
Необходимые системные требования для работы программного обеспечения трехмерной анимации: 
Windows NT4, Win95, Win98, Win ME, Win2K, или Win XP, OpenGL ускоренная графическая карта с полной поддержкой ICD, (ala GeForce), как минимум 64 МБ оперативной памяти, 128 МБ (рекомендуется) или 256 МБ, в том случае, если вы пользуетесь Win XP, 300 МГц Pentium, места на диске 5 МБ. 
Некоторые из наиболее популярных программных обеспечений для созданий анимации:
Ulead Animation, Ulead GIF Animator 5, CoffeeCup Animation Software, CoffeeCup GIF Animator, CoffeeCup Firestarter, Firestarter, Reallusion Animation Software, Effect3D Studio, 3D Max, Toonboom Studio, Macromedia Flash.

GIF-анимации используется возможность этого формата хранить в файле несколько изображений — анимационные gif’ы представляют собой серию кадров, быстро сменяющих друг друга, за счет чего и достигается анимационный эффект. Кадры, например независимые изображения или отдельные слои одного изображения, можно создать в любом графическом пакете — в Adobe Photoshop, Jasc Paint Shop Pro и др. А вот превращение их в анимационный gif-файл, содержащий не только все исходные изображения, но и данные о скорости их вывода на экран, применяемую палитру, звук и пр. (причем в сильно сжатом виде), осуществляется уже при помощи специальных программ. Сегодня благодаря широкому использованию в Web-дизайне формата Animation GIF число таких программ очень велико.
Классификация программ для создания gif - анимаций.
По большому счету все программы для создания анимационных gif’ов можно разделить на три группы:
1. В первую входят популярные двумерные графические пакеты, ориентированные в первую очередь для работы с двумерной растровой графикой и вместе с тем позволяющие создавать файлы в формате Animation GIF за счет дополняющих их соответствующих утилит. Наиболее популярные из них — Adobe Photoshop с входящей в его состав программой ImageReady, Jasc Paint Shop Pro, в поставке которого имеется программа Animation Shop, и Ulead PhotoImpact с программой GIF Animator. Основным преимуществом приложений данной группы является то, что анимационная программа тесно связана с соответствующим графическим пакетом и потому возможно быстрое переключение между программой-аниматором и графическим редактором при необходимости скорректировать изображение. Это удобно только в том случае, если вы разбираетесь во всех тонкостях работы с подобными пакетами (все они, в особенности Adobe Photoshop, требуют серьезной подготовки). По этой причине данный вариант в большей степени подходит для профессионалов, а новичкам лучше выбрать одну из программ второй группы.
2. Во вторую группу входят пакеты, предназначенные исключительно для создания анимационных gif’ов. Как правило, они обладают ограниченными возможностями в плане рисования, поэтому исходные изображения для анимации создаются в любом из графических пакетов — данные gif-аниматоры не привязаны к конкретному графическому приложению. Причем совсем не обязательно выбирать для работы сложные пакеты, такие как Adobe Photoshop, Jasc Paint Shop Pro и Ulead PhotoImpact. Возможность использования привычного графического пакета можно считать главным преимуществом gif-аниматоров из данной группы. К тому же независимые программы для разработки анимационных gif’ов имеют небольшие по объему дистрибутивы, поэтому их без проблем можно приобрести через Интернет. И наконец, в большинстве своем приложения из этой группы очень просты, поэтому их можно быстро освоить.
3. Третью группу образуют программы, ориентированные на создание 3D-графики (например, 3D Studio Max) и вместе с тем позволяющие создавать анимацию в формате Animation GIF (обычно за счет специального плагина, часто включаемого в поставку). Графические 3D-программы удобны тем, что не требуют покадровой прорисовки — обычно для создания gif-файла бывает достаточно задать объекту некое циклическое действие, например поворот вокруг оси, записать полученную анимацию как серию кадров и экспортировать ее в анимационный gif. Однако есть одно «но» — традиционные программы для работы с трехмерной графикой требуют глубоких профессиональных знаний и сложны в применении. Но не стоит отчаиваться! Если вам необходимо создать, например, анимированный трехмерный логотип, то вполне можно обойтись программой Xara3D, которая хоть и позиционируется для работы с трехмерной графикой, однако умеет создавать и анимационные gif’ы и очень проста в применении.
Добавим, что в группу программных продуктов, ориентированных исключительно на создание анимационных gif’ов, входят пакеты, которые также можно использовать для создания трехмерных анимационных кнопок и логотипов, правда они получатся не столь эффектными, как при применении программы Xara3D.
Рассмотрим некоторые технологии и принципы создания анимации.
Ulead GIF Animator
Ulead GIF Animator входит в графический пакет Ulead PhotoImpact, однако может использоваться и автономно — для создания анимированных gif’ов на основе изображений, созданных в любом графическом пакете. Благодаря удобному и интуитивно понятному интерфейсу и богатым возможностям, эта программа считается сегодня одним из самых удобных и функциональных gif-аниматоров и значительно экономит время web-дизайнера, поскольку может распознавать изменения, сделанные во внешних редакторах (PhotoImpact, Photoshop или Paint Shop Pro), и автоматически обновлять соответствующие кадры в анимации. Анимированный рисунок может быть экспортирован в формат PhotoImpact (UFO) или Photoshop (PSD) с сохранением разбивки на слои. Кроме того, можно выделить любой слой рисунка, созданного в графическом редакторе PhotoImpact, Photoshop или Paint Shop Pro, как отдельный объект для GIF Animator.
 

Программа предоставляет богатый набор средств композиции, редактирования, наложения спецэффектов, оптимизации и экспорта. Динамическая анимация многослойных рисунков на основе полноцветной объектно-ориентированной модели позволяет легко манипулировать несколькими объектами на рисунке и быстро создавать многообъектные анимации, а динамическое обновление изображений, созданных во внешних редакторах, устанавливает новый стандарт интеграции. Мастер анимаций упрощает размещение изображений на рабочем поле и дает возможность мгновенно оценить качество созданной анимации на основе ее демонстрационного показа в окне предварительного просмотра. Диспетчер объектов помогает вести учет всех объектов рисунка, а функции построения промежуточных кадров позволяют автоматизировать процесс анимации, генерируя промежуточные позиции выбранных объектов.
Среди возможностей Ulead GIF Animator — анимация текста и наложение более 130 анимационных эффектов. Реализованные в программе усовершенствованные методы сжатия изображений позволяют добиться существенного уменьшения размеров анимационных файлов, автоматическая генерация HTML-кода значительно ускоряет процесс вставки готовых анимаций в web-страницу, а поддержка экспорта в различные форматы, включая Flash, AVI, MPEG и QuickTime, делает программу еще более привлекательной.



ImageReady CS
Программа ImageReady CS входит в состав популярного пакета Photoshop CS от компании Adobe и предназначена для разработки различных Web-элементов, в том числе анимированных gif’ов, что с учетом полной совместимости с Photoshop делает ее прекрасным инструментом для web-дизайна, рассчитанных на профессионалов. Photoshop и ImageReady работают в тесном взаимодействии и прекрасно дополняют друг друга, а редактируемый файл можно без проблем перемещать между программами во время редактирования с автоматическим его сохранением. Возможен экспорт созданных анимированных gif-файлов в формат Macromedia Flash (SWF).
Анимированные gif’ы могут создаваться как на основе многослойных файлов Adobe Photoshop и Adobe Illustrator, так и из отдельных изображений, сохраненных в различных графических форматах. При создании анимации на основе серии изображений для монтажа кадров не обязательно нужно загружать каждое изображение отдельно — можно воспользоваться возможностью импорта из папки, в которой предварительно были сохранены отдельные кадры будущей анимации. Возможно автоматическое формирование необходимого количества промежуточных кадров, значительно ускоряющее получение плавных анимаций, так как отпадает надобность вручную создавать каждый кадр. В окне программы можно сразу же просмотреть результат и при необходимости внести требуемые изменения.
рис. 1
ImageReady имеет большую галерею фильтров, аналогичных многим известным фильтрам Photoshop. Поэтому для добавления к кадру того или иного эффекта не всегда надо переключаться в Photoshop — многие действия доступны и из среды ImageReady.
Для перехода из Photoshop в ImageReady и обратно нажмите левой кнопкой мыши на последней строчке вертикальной панели инструментов – Edit to Image Ready (Открыть в Image Ready), либо просто одновременной удерживайте комбинацию клавиш Shift+Ctrl+M: 
рис. 2
Панель Animation можно вызвать командой Window > Animation (Окно > Анимация).
При GIF-анимации набор кадров изображения воспроизводится в порядке, определенном пользователем. Для Web-страницы можно создать различные анимационные эффекты: сделать так, чтобы текст или графика перемещались, постепенно исчезали или появлялись, либо изменялись другим способом. 
Для подготовки анимации в программе ImageReady необходимо создать множество кадров изображения с помощью палитры Animation (Анимация), показанной на рис. 3. Затем можно редактировать отдельные слои каждого кадра с помощью палитры Layers (Слои) рис. 4, причем у каждого кадра будет собственная уникальная совокупность установок на палитре Layers. И наконец, надо сохранить последовательность кадров в виде одного GIF-файла — теперь анимация готова для просмотра в интерактивном режиме.
   рис. 3
    рис. 4
Эффекты слоя
Программа ImageReady предлагает тот же набор эффектов слоя, что и Photoshop. Но программа Photoshop регулирует свойства слоя с помощью диалогового окна Layer Style (Стиль слоя), a ImageReady - с помощью контекстной палитры опций слоя. 
Эффекты в программе ImageReady обладают теми же характеристиками, что и в Photoshop: их названия отображаются под именем слоя, к которому они применены; эффекты перемещаются вместе со слоем; на элементах палитры есть обращенные вправо стрелочки, с помощью которых можно открыть или закрыть список эффектов. У каждого эффекта есть свой собственный значок, позволяющий отобразить или скрыть данный эффект.
Создание анимационного эффекта для какого-либо изображения. 
1. Откройте или создайте изображение, содержащее фоновый слой и прозрачный слой с рисунком какого-либо предмета.
2. Откройте палитру Animation (Анимация). 
3. Выберите слой на палитре Layers (Слои). 
4. С помощью инструмента Move (Перемещение) перетащите элемент изображения к краю основного окна. 
5. В нижней части палитры Animation щелкните по кнопке Duplicate current frame (Дублировать текущий кадр). Скопированный кадр будет выделен. 
6. Слой, выбранный на шаге 3, должен оставаться выделенным. 
7. С помощью инструмента Move (клавиша V) перетащите элемент слоя на другую сторону основного окна. Оставьте этот слой выделенным! 
8. На палитре Animation щелкните по кнопке Tween (Промежуточные кадры) для построения промежуточных кадров между уже выбранными. 
9. В диалоговом окне Tween (Промежуточные кадры) поставьте переключатель Layers (Слои) в одно из следующих положений: 
· All Layers (Все слои), чтобы скопировать точки со всех слоев в новые кадры. 
· Selected Layer (Выделенный слой), чтобы скопировать точки только выделенного слоя в новые кадры. Все другие слои будут спрятаны. 
Затем установите в группе Parameters (Параметры) флажки тех параметров, которые будут изменяться в промежуточных кадрах: Position (Расположение), Opacity (Непрозрачность) и/или Effects (Эффекты). 
Из всплывающего меню Tween with (Диапазон промежуточных кадров) выберите режим Previous Frame (Добавление промежуточных кадров между выделенным кадром и предыдущим).
Выбор параметров воспроизведения анимации 
Из всплывающего меню, расположенного в нижнем левом углу палитры Animation (Анимация), выберите режим воспроизведения, указывающий, как будет воспроизводиться цнимация: Once (Однократно) или Forever (Непрерывно в цикле). Либо включите опцию Other (Иначе), чтобы указать определенное количество воспроизведений анимации, а затем щелкните по кнопке ОК.
Предварительный просмотр анимации 
1. В основном окне выберите вкладку Original (Исходное изображение) или Optimized (Оптимизированное изображение).
2. Если первый кадр не выделен, то в нижней части палитры Animation (Анимация) щелкните по кнопке Select first frame (Выделить первый кадр).

рис. 5. Дублирование кадра анимации 
3. Щелкните по кнопке Play (Проиграть) - см. рис 5. Анимация будет воспроизводиться чуть медленнее, чем должна. (Предварительный просмотр в программе ImageReady происходит медленнее, чем в браузере.) 
4. Щелкните по кнопке Stop (Остановить), которая имеет вид квадрата, чтобы приостановить воспроизведение. 
5. Сохраните файл, затем щелкните по кнопке Default Browser (Предварительный просмотр в браузере по умолчанию), расположенной на панели инструментов. Щелкните по кнопке Back (Назад), чтобы вернуться в программу ImageReady, когда просмотр будет закончен.
Анимация покачивания предметов 
Далее рассмотрено, как сделать так, чтобы элемент слоя покачивался из стороны в сторону. Этот тип анимации затрагивает точки слоя и копируется во все существующие кадры. Необходимо создавать дубликат слоя для каждого этапа движения. 
Создадим анимацию, в которой объект будет перемещаться в определенном направлении и обратно. 
1. Откройте изображение и палитру Animation (Анимация). 
2. В нижней части палитры Animation щелкните по кнопке Duplicate current frame (Дублировать текущий кадр). Теперь будет выделен дубликат кадра. 
3. На палитре Animation щелкните по кнопке Tween (Промежуточные кадры), а затем поставьте переключатель Layers (Слои) в положение All Layers (Все слой), введите число кадров в поле Frames to Add (Добавить кадры), чтобы создать анимацию, и щелкните по кнопке ОК. 
4. Щелкните по кадру, в котором должно начаться покачивание. 
5. На палитре Layers (Слои) создайте дубликат того слоя, изображение которого будет двигаться. 
6. Отредактируйте дубликат слоя (например, подкорректируйте цвет). Спрячьте исходный слой, чтобы увидеть внесенные изменения. Изменения отразятся в выделенном кадре на палитре Animation. 
7. Выберите следующий кадр. Сделайте исходный слой receiver видимым и спрячьте его отредактированный дубликат. 
8. Щелкните по следующему кадру. Теперь покажите отредактированный дубликат слоя и спрячьте исходный слой. 
Так попеременно показывайте/прячьте слои для оставшихся кадров анимации.
Открытие анимации в формате GIF 
Единственное видимое преимущество использования формата GIF - это возможность применения или редактирования настроек оптимизации файла. 
1. Выполните команду File > Open (Файл > Открыть) либо нажмите комбинацию клавиш Ctrl+O. 
2. Найдите название файла с расширением .gif и щелкните по нему. 
3. Щелкните по кнопке Open (Открыть). Кадры анимационной последовательности при этом будут сохранены. Однако на палитре Layers (Слои) теперь станет отображаться последовательность слоев: по одному слою для каждого кадра. Отдельные элементы слоя теперь нельзя редактировать независимо от других кадров! 
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1. В меню палитры Optimize (Оптимизация) воспользуйтесь командой Optimize Animation (Оптимизировать анимацию). 
2. В группе параметров Optimize By (Оптимизировать с помощью) установите флажок Bounding Box (Габаритная рамка), чтобы сохранить первоначальный кадр, а также только те области, которые изменяются при переходе от одного кадра к другому. В результате уменьшится размер файла, но в то же время не все программы-редакторы, воспринимающие формат GIF, смогут работать с данным файлом. 
В дополнение к этим действиям или вместо них установите флажок Redundant Pixel Removal (Удалить лишние точки), чтобы удалить те точки объекта или фона, которые не меняются, то есть повторно выводятся при загрузке каждого нового кадра. Это также поможет уменьшить размер файла.
Ни одна из этих опций не изменит фактического вида анимации, все изменения происходят «за сценой». 
Сохранение анимации.
Созданную анимацию можно сохранить в формате GIF либо как фильм QuickTime. Другие форматы файлов, такие как JPEG или PNG, сохранят только первый кадр изображения, не позволяя воспроизвести всю анимацию. Существует несколько способов сохранить оптимизированную анимацию для использования на Web-странице. В ImageReady достаточно выбрать команду File > Save Optimized (Файл > Сохранить оптимизированный), чтобы сохранить анимацию с установками, выбранными при предыдущем ее сохранении. Если это не первое сохранение, то диалоговое окно Save (Сохранить) не появляется и название файла и его параметры остаются теми же, что были присвоены ранее.
Выбор команды File > Save Optimized As (Файл > Сохранить как оптимизированный) позволяет изменить имя файла и выбрать другое место его хранения. Кроме того, возможен выбор измененного параметра Save As Type (Тип файла) из набора доступных значений:
· HTML and Images (HTML и рисунки) — генерирует HTML-файл и сохраняет каждый изображение в виде отдельного файла; 
· Images Only (Только рисунки) — сохраняет только изображение в отдельном файле; 
· HTML Only (Только HTML) — сохраняет только HTML-файл без файлов изображений. 
Кроме того, ImageReady позволяет создать HTML-файл по команде Copy HTML (Копировать HTML), которая копирует код HTML в буфер обмена, а затем он может быть вставлен на Web-страницу в любом HTML-редакторе. В случае изменений исходного изображения для обновления HTML-файла выполняют команду Update HTML (Обновить HTML) с указанием имени обновляемого файла.
Чтобы сохранить анимацию в формате QuickTime, следует выбрать команду File > Export Original (Файл > Экспорт начального) и из раскрывающегося списка выбрать значение QuickTime Movie (оно будет доступно, если на компьютере установлена программа QuickTime). Указав имя файла и его место расположения, щелчком на кнопке Save (Сохранить) создаем файл выбранного типа.


Как сделать анимированный дождь.
Шаг 1. Открываем изображение.
Шаг 2. Создаем новый слой и заливаем его серым цветом. И применяем к нему фильтр Filter - Noise - Add noise и выставляем такие настройки.

Затем применяем фильтр Filter-Blur-Motion Blur.

Ставим прозрачность слоя 30%
Шаг 3. Снова создаем новый слой и заливаем его серым цветом и применяем те же фильтры как в шаге номер два.но фильтр Motion Blur уже делаем с другими настройками.

и ставим прозрачность слоя 30%
Шаг 4. Опять повторяем все тоже самое что мы проделывали в шаге 2. Фильтр Motion Blur делаем с такми настройками и ставим прозрачность слоя 30%.
Шаг5. Переходим в Image Reader делается это с помощью сочетания клавиш (Shift+Ctrl+M)
Шаг 6. Делаем длину кадра 0,1sec.
Шаг7. Делаем два дубликата нашего кадра.
Шаг 8. Переходим на первый кадр и делаем чтобы виден был только первый слой с каплями которые мы сделали.
Шаг 9. Переходим на второй кадр и делаем чтобы виден был только второй слой с каплями которые мы сделали.
Шаг 10. Переходим на третий кадр и делаем чтобы виден был только третий слой с каплями которые мы сделали.
Всё наша анимация готова!
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В отличие от большинства программ для работы с трехмерной графикой, Xara3D имеет простой и дружественный интерфейс и минимальное число настроек, благодаря чему в ней легко и быстро разберется даже новичок. И хотя программа предназначена в первую очередь для создания объемных текста и кнопок, она прекрасно подходит и для получения анимаций в форматах Animated GIF и AVI. Поэтому она с успехом используется web-дизайнерами преимущественно для создания профессиональных трехмерных текстовых логотипов.

В арсенале программы — большой набор шрифтов и текстур для оформления создаваемых объектов. Она обеспечивает полный контроль над создаваемым текстом, включая его положение, выравнивание, интерлиньяж, кернинг и пр., эффективное и гибкое управление цветом и структурой трехмерного изображения. Кроме того, изображения можно сделать матовыми или блестящими, наложить на них мягкую обрамляющую тень и т.п. Достаточно широк выбор анимационных эффектов: объекты могут вращаться, постепенно проявляться, пульсировать, наступать, качаться или исчезать. Кроме того, можно импортировать особенности анимации из одного файла и применить их к другому. Простые средства управления анимацией позволяют установить любые временные границы, например добавить разные по времени паузы, или задать свои особенности анимации для каждого объекта.
Программа поддерживает импорт двумерных графических файлов в форматах WMF, EMF, GIF и PNG, а результаты анимации можно сохранить не только в формате Animation GIF, но это при желании и в форматах AVI или SWF.

Macromedia Flash
 Adobe Flash, или просто Flash называют Adobe Flash Player и Adobe Flash Professional, программу разработки мультимедийного контента для платформы «Adobe Engagement Platform» (такого, как веб-приложения, игры и мультфильмы).
Если быть точнее, Adobe Flash - среда для создания приложений под Flash платформу (Flash Platform), наряду с ней существуют и другие инструменты (среды):
- Adobe Flex Builder;
- Flash Development Tool (FDT) и др.
Flash-приложения создаются с помощью ActionScript - языка программирования. Если исходник не содержит в себе инструкции языка, то при компиляции, в любом случае, генерируется некоторый базовый код на ActionScript (это можно увидеть, просмотрев Flash-байткод). Далее, соответственно, существует базовый клип на сцене, унаследованный от MovieClip класса, который и начинает воспроизводиться. Среда Adobe Flash ориентирована в большей мере на дизайнеров, аниматоров, хотя и имеется возможность писать полноценный код. Flex Builder, FDT, ориентированы на программирование, и там нет специальных инструментов интерфейса для анимации, визуализации.
Flash одновременно употребляется и как название формата (флеш-фильмы, флеш-мувики) (полное название - Flash Movie).
При создании продукта можно использовать звуковые и графические файлы, можно создавать интерактивные интерфейсы и полноценные веб-приложения с использованием PHP и XML.
Flash-файлы имеют расширение «.swf» и просматриваются с помощью Flash Player, который может быть установлен как plugin в браузер. Также swf-файлы можно просматривать с помощью плеера Gnash. Распространяется бесплатно через сайт Adobe. Исходные файлы с расширением «.fla» создаются в среде разработки Adobe Flash, а потом компилируются в понимаемый Flash Player формат — «.swf».
В основе Flash лежит векторный морфинг, то есть плавное «перетекание» одного ключевого кадра в другой. Это позволяет делать достаточно сложные мультипликационные сцены, задавая лишь несколько ключевых кадров для каждого персонажа.
Flash использует язык программирования ActionScript, основанный на ECMAScript.
Технология векторного морфинга применялась задолго до Flash. В 1986 году была выпущена программа Fantavision, которая использовала эту технологию. В 1991 году на этой технологии была выпущена игра Another World, а двумя годами позже — Flashback.
История же Flash началась в 1995, когда после покупки программы для анимации FutureSplash Animator, компания Macromedia выпустила продукт под названием Flash.
Flash начинал свою профессиональную деятельность с выпуска обычного двухмерного анимационного программного продукта. Шло время, всё развивалось быстрыми темпами. Не обошло развитие стороной и Flash, он стал более современным и совершенным. 
Сегодня существуют так называемые 3D-движки, например: 
-Sandy3d;
- PaperVision3D, но их скорость и качество работы довольно низки, в основном из-за того, что на настоящий момент в составе flash player нет возможности использовать средства directX или openGL, так что выполняется полная эмуляция всех 3d-алгоритмов. Нет поддержки аппаратной акселерации, многоядерных процессоров - что также снижает скорость работы движка. Однако дизайнерами часто выполняется создание собственного 3d-движка заточенного под специфику конкретного проекта (игры).
Сегодня большинство браузеров имеют специально встроенный плагин Macromedia Flash Player, позволяющий им проигрывать Flash-файлы. Технология Flash заняла в Интернете доминирующее положение и стала стандартом в области отображения на веб-сайтах векторной анимации. Без Adobe Flash Player браузеры будут некорректно отображать веб-страницы и встроенные в них интерактивные веб-элементы, разработанные по технологии Flash.
Интерфейс Macromedia Flash.
рис.1
При открытии окна приложения Flash на экране появляются следующие элементы интерфейса:
· Stage (рабочий стол) — область для компоновки отдельных кадров, создания композиции из графических элементов или импортированных точечных изображений и просмотра результатов анимации; 
· Timeline (ось времени) — окно, содержащее список отдельных слоев с расположенными на них графическими объектами и их распределением во времени (на оси времени отмечен каждый кадр фильма); 
· Symbols (символы) — основные элементы фильма, как правило, многократно в нем используемые; 
· Library (библиотека) — окно со списком символов и импортированных файлов, позволяющее выполнять их организацию и сортировку; 
· Floating, dockable panels (пристыковываемые панели) — окна с набором вкладок, служащие для настройки приложения и изменения параметров элементов фильма; 
· Movie Explorer (обозреватель фильма) — дополнительно вызываемое окно для просмотра структуры фильма. 



Покадровая анимация 
Итак, еще раз окинем взглядом окно программы Flash. Когда в нем открыт какой-либо ролик, в верхней части окна располагается так называемая шкала времени (timeline). В ее левой части приведены названия слоев, о которых мы поговорим в этой главе чуть позже, и их атрибуты. А в правой части обозначены пронумерованные кадры ролика (рис. 4). Благодаря нумерации кадров это окно и называют шкалой времени - ведь в ролике кадры следуют один за другим. 

Рис. 4
На шкале времени расположен красный прямоугольник, которым всегда выделен текущий кадр.


Заключение:
В мире современных технологий  анимация становится одним из главных элементов мультимедиа проектов и презентаций,  все чаще присутствует на интернет – страницах.
В данной работе рассмотрены наиболее распространенные средства поддержки и создания анимации, а так же описаны этапы создания gif – файлов, flash - роликов и анимированного объемного текста, с применением различных эффектов.
Xara3D – программа для работы с трехмерным текстом имеет дружественный интерфейс и минимальное число настроек, считается простой и удобной.
Благодаря удобному и интуитивно понятному интерфейсу и богатым возможностям Ulead GIF Animator считается сегодня одним из самых удобных и функциональных программ для создания gif - файлов и значительно экономит время web-дизайнера
Macromedia Flash Professional является ведущим инструментом для создания мультимедийного информационного наполнения. Это программное средство интегрируют текст, графику, аудио- и видеоданные, образуя интерактивную мультимедийную среду, которая обеспечивает блестящие результаты при создании интерактивных презентаций, маркетинговых материалов, электронных учебных ресурсов и графических пользовательских интерфейсов.
Macromedia Flash Professional объединяя более миллиона разработчиков и пользователей в различных странах мира, использующих разнообразнейших вычислительных устройств. Технология Macromedia Flash считается самой распространенной программной плотформы.
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